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1 In-Application Support Overview 
The Player deployment format that is published from the Developer is not only useful in 
various training and educational initiatives; it is also designed to provide in-application support 

for end users.  
  
There are specific add-ons and instructions for certain major enterprise applications to 
accommodate context-sensitive in-application support; these applications are referred to as 
target applications throughout this document. Content for target applications can generally be 

deployed using one or both of the following methods, depending on the target application:  

 Help Integration: This method allows users to invoke context-sensitive in-application 
support content using the existing target application Help menu or Help link. 

   

 SmartHelp: This is a toolbar button for browsers that end users may use to access 
context-sensitive in-application support content.  

The mechanism for context-sensitivity used for target applications is known as ExactMatch. 
This technique allows the Player to display a list of content that is related to the end user's 
activity in the application. The relevancy of the content list is determined based on content 

items that contain exactly the same context information as recorded during content creation in 

the Developer.  
  
The mechanism for context-sensitivity for browser-based non-target applications is known as 
SmartMatch. This technique uses statistical analysis to rank the most probable content items 
and generates a list of relevant content. This allows you to use the SmartHelp toolbar button 

to deploy context-sensitive in-application support for any browser-based application.  
  
Finally, content created for non-target applications prior to the introduction of SmartMatch 
technology may still be deployed using the SmartHelp toolbar button for the browser without 
context-sensitivity. In this case, the outline displays all of the content items; however, the 

user may find the appropriate items using the Search feature or by browsing the content 

outline.  
  
See the Content Deployment manual for more information about deploying Player content. 

1.1 Plan for Deploying In-Application Support 
Once you decide to deploy content for in-application support, some of the fundamental 

questions that need to be addressed are:  

 What deployment mechanism is most appropriate for your application, Help 

Integration with a target application or SmartHelp-based deployment? 

  

 Who needs to be involved, what needs to be done, and when does it have to happen?  

Understanding the answers to these questions will give you the information you need to 

implement help integration and context-sensitive help successfully.  
  
These are the tasks which need to be completed to successfully deploy in-application support. 
  
Content Author 

 Create content in the Developer: While context for many applications will be 
automatically captured, it is recommended that you validate that context is being 
captured. You can check this by opening the topic in the Topic Editor and then opening 
the Context ID editor. If the Type field displays SmartMatch or ExactMatch, context 
was captured. If it displays NoMatch, no context was captured. In addition, while you 
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are recording a topic, there is an icon in the Recorder which shows context recognition 

status. 

  

 Publish the content 

  

 Give the published content to the web server administrator 

Web Server Administrator   

 Deploy the published content to a web server 

  

 Provide the URL for the content to the application administrator and access to that 
directory so the application administrator can create the necessary configuration files. 

Application Administrator   

 Perform the configuration steps detailed in this guide for each application 

   

 Receive the content URL from the web server administrator 

    

 Perform help integration steps for URL configuration, if applicable 

Test User   

 Verify the published content appears from the application using the Help Menu 
Integration option or the SmartHelp button, as deployed 

If you are deploying context-sensitive help, the test user should coordinate with the content 
developer to note which parts of the application were used to create content and then verify 

that the content launches with an appropriate list of relevant topics.  

1.2 Target Application Configuration and Content Creation 
For most target applications, application configuration can occur after and independently of 
content creation. There are two exceptions:  

 Oracle E-Business Suite: It requires library files to be installed on the application 
server (applcore forms server) before recording content. See Implement Context-
Sensitive Help Integration in the Oracle E-Business Suite section later in this manual 

for more information on installing library files for Oracle E-Business Suite. 
   
Note: Oracle E-Business Suite 12.1.2 no longer needs the library files; however, you 
should add a profile in the System Profile form. 
  

 PeopleSoft Enterprise: It is recommended that PeopleBooks be installed and 
configured before starting to record content. 

If you want to deploy context-sensitive help, always check that context is being captured while 
recording. See Context Recognition in the Recorder in the Record and Edit Topic Content 
chapter of the Content Development manual for more information on capturing context while 
recording.  
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2 Implement In-Application Support 
End users access in-application support in one of two ways. The first is via a help link, button, 
or menu item in the recorded target application. This option is called help integration and 

requires an application administrator to make minor configuration changes in the target 
application to enable the Player context-sensitive help. The second option, called SmartHelp, is 
to install a toolbar button in a browser in which a user launches the target application. This is 
installed as a browser add-on and may require the help and approval of your Information 
Technology resources.  

  
Applications supported by:  

  
SmartHelp only  

  
Oracle (Siebel) CRM On Demand  

Oracle Transportation Management  
SAP NetWeaver Portal  

Any browser-based application with HTML user interface (as long as the browser/version is 

supported by SmartHelp)  
  
Help Integration only  

  
JD Edwards World  

SAP GUI for Windows  

  
Either SmartHelp or Help Integration  

  
Agile CNM  

Agile PLM  

JD Edwards EnterpriseOne  

Microsoft Dynamics CRM (version 4)  

Oracle E-Business Suite (SmartHelp not supported for Oracle Java Forms)  

Oracle (Hyperion) EPM 

Oracle Fusion Applications  

Oracle Knowledge Center  

PeopleSoft  
Primavera P6  

Primavera Contracts Management 
SAP GUI for HTML  

Siebel CRM (On Premise)  

  
Refer to the following information for the general steps to implement SmartHelp or help 
integration.  

  
Implement SmartHelp  

 Obtain content in the form of a Player package that an author created and published 
from the Developer. 

   

 Configure content using the In-Application Support Player Configuration utility to set 
options for SmartHelp. See Configure SmartHelp. 
   

 Deploy content to a web server. 

   

 Install SmartHelp by deploying a link or pushing it to the end users. See Install 
SmartHelp for Browser-based Applications. 
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Implement Help Integration  

 Obtain content in the form of a Player package that an author created and published 
from the Developer. 
   

 Configure content using the In-Application Support Player Configuration utility to set 

options for help integration. See Application-Specific Configuration Settings. 
   

 Deploy content on a Web server. Integrate Help into the target application by 

adjusting settings in the target application to launch the content. See the appropriate 
section for your application in Integrate Help for Target Applications. 

Details about each step are in the following sections.  

2.1 Obtain Content 
Whether you are implementing help integration or SmartHelp, you need content that has been 
published to the Player format from the Developer. You can create and publish this content 
yourself, or you can use purchased content from your enterprise application vendor.     

 Create and publish content – An author will use the Developer to create and record 
content, and then publish it to the Player format. This results in a folder structure 
containing a subfolder with the name PlayerPackage. It is this PlayerPackage folder 
that you need.  
   

 Purchase content – Some enterprise application vendors sell pre-packaged content for 

their applications to help customers understand application functionality and 
configuration options. If you purchase content, you should receive a complete 
PlayerPackage.  

2.2 Configure Content 
Whether you are configuring content for SmartHelp or help integration or both, there are 

options you can set for context sensitivity and launch behavior.   
  
The published content contains the In-Application Support Player Configuration utility to help 

you make the appropriate settings for your needs.  

2.2.1 Use the In-Application Support Player Configuration Utility 

As you use the In-Application Support Player Configuration utility to change and save settings, 
it creates a configuration file, writes the necessary lines of code, and saves it to the 

appropriate location.  

  
If a target application supports help integration, there is a link specifically for that target 
application on the home page of the utility. There is also a link for SmartHelp options at the 
bottom of the page. The options on the SmartHelp page apply to all target applications that 
support SmartHelp, plus all browser-based applications since SmartHelp can be deployed for 
any application that runs in a browser, except ones that hide the browser toolbar.  

  
Note: When you publish a Player package, only the target application folders that were 
recorded in the content are included. When you launch the utility, it will only display links to 
configure these applications. If you want to configure other target applications as well, you 
can copy other target application folders into the Player package. When the utility detects the 
additional folders, it will display links for those applications as well. All of the target application 
folders are stored in the Library in a package called hintconfig. It is in the same location as all 
of the other folders, that is, /System/Publishing/In-Application Support/<brand>.   

  
As you make changes to the configuration settings and save them, the Activity column on the 
home page displays information about the date and time the change was made, and the name 
of the person who made them. You can add a name in the My name is field at the top of the 
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page. If you add your name, or pick your name from the dropdown list, it appears in the 
Activity column and also on Notes. You can add or change your name on any page. On the 
home page, you can also change the language of the interface.  

  

To launch the In-Application Support Player Configuration utility (locally):  

1. Navigate to the folder containing the Player package. 
  

2. If you use Internet Explorer, launch the inappconfig.cmd file. 
   
or 
   
If you use Mozilla Firefox, launch the inappconfig_ff.cmd file. 

Use Notes  

You can add a note to each option as well as to the configuration file as a whole. These notes 
are saved as comments in the configuration file. You can use notes to add information about 
why a change to the configuration was made, and so on.  

  

To add, edit, or delete a note:  

1. Launch the Configuration Utility and open a page for an application. 
  

2. To add a note for a field, click  in the blue bar next to that field. 
   

or 
   

To add a note for the configuration file as a whole, click  in the Notes box at the top 

of the page. 
  

3. Enter the text of the note and click Ok. 
   

4. To edit a note, click in the text box for the note, make your changes, and click Ok. 

   

5. To delete a note, click  on the note. 

Save the Configuration File  

If you are launching Configuration Utility from the command file, the configuration file 
(odcustomurl.js) is saved directly to the appropriate folder within the content folder on the 
local drive.  

  
Note: If you are not sure that the configuration file was saved correctly, you can retry the 
save. The Save Configuration page appears, displaying the location where the file was saved. 
If necessary, you can save the file manually, and then use the Check option to verify that the 
file is in the correct location.  

  

To save the configuration file locally:  

1. Click Save. The Check Configuration page appears displaying the name of the file and 
the location where it was saved. 

Revert Settings  

At the bottom of each page of configuration settings, there is a Revert button. This option 
changes all of the settings on the page back to what they were the last time that the 
configuration was saved.  
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To revert the settings:  

1. Click Revert. 

Reset to Defaults  

You can also set options back to the original settings. There is a Reset to Defaults button at 
the bottom of each page, which sets all the options on the page back to original defaults.  

  

To reset to defaults:  

1. To reset all of the fields on a page to the default, click the Reset to Defaults button 
at the bottom of the page. 

2.2.2 SmartHelp 

When you record browser-based application content, the content can be deployed with the 
SmartHelp toolbar button. The published content must be hosted on a web server and then 

SmartHelp can be installed from the hosted content location. The options on the SmartHelp 
configuration page allow you to configure SmartHelp for multiple applications and languages.   
 

Note: If you have content created in different versions of the Developer, republish the content 
and SmartHelp from the same Developer version. 
 

If you want to configure multiple applications, you must enter a URL for each application. For 
each URL, you must also configure a default language.  
 

SmartHelp and Languages   

You can configure SmartHelp to launch content in multiple languages. When you specify a 
language for the content at a specific URL, you can choose a base language and a language 
with a regional code, for example "en" for English, "en-us" for United States English, and "en-
gb" for British English.  
 

Users specify preferred languages for web pages, in order of preference, using the language 

settings in their web browser. When a user launches SmartHelp, it checks the language 
preference in the browser settings to find the appropriate content to launch for the application. 
It first tries to match the first preferred language, including the regional code. If there is none, 
it then looks for the preferred language with no regional code. If none is found, then it 

performs the same search for the second preferred language, and so on down the list. If no 
URL for content is found in any of the preferred languages, then it launches the content in the 
default language specified for the application.   
 

Therefore, when you configure SmartHelp, you must always specify a default language for 
each application.  
 

The SmartHelp Configuration page provides three options:  

 Application: Provides a list of all supported applications. Choose the one that is 
appropriate for the content. 
  

 Language: Provides a list of languages with region codes. Choose the one that is 

appropriate for the content. 
  

 URL: Enter the URL to the root folder for the content, for example, 

http://<servername>/<content folder>. Do not enter a specific page, such as 
index.html. 
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To configure SmartHelp options:  

1. Launch the Configuration Utility. 

   
2. Click the SmartHelp link. 

   
3. In the Application field, choose the application for which you want to specify a 

content location. 

   
4. In the Language field, choose the language for the content at the location. 

   
5. In the URL field, enter the URL to the application content folder. 

   
6. If you have more than one application for which you want to enable SmartHelp, click 

 and enter another URL. 

   
7. Click Save.  

   

Note: To delete a row, click  in the grey bar. You can also rearrange the rows using 

 and .  

2.2.3 Target Application-Specific Configuration Settings 

For target applications that support help integration, there are three possible feature 

configurations: Gateway, Multi-Language Content, and Advanced Options. Certain target 

applications have additional special options.  
  
Configure Gateway  
The options in this feature allow you to configure a gateway page that launches when a user 
clicks the Help link. You can configure the gateway page to give the user access to additional 

resources, such as the original help for the target application, additional Player packages, or a 

URL to another web site.  
  
The gateway page has two options, tabs and links. The tabs appear across the top of the 
page, and you can specify the text for the tab as well as the URL to the content. The links 
appear in a menu on the last tab, and you can specify the link text as well as the target of the 
link. In most cases, it is your choice whether to use a tab or a link. There are a few 
exceptions. Some web pages cannot be embedded in a tab, so you must use a link to launch 
them. An entry for the target application help may appear in either the Tab or the Link Type 

list, depending on whether it can be embedded. In addition, the default player content (see 

Default Content URL below) will always appear as the first tab.  

 Default Player Tab Text: The default Player is the one you launched the 
configuration utility from. This is the Player that launches if you do not configure the 
gateway page. In addition, if you configure any kind of content segmentation, such as 
multi-language support, it only applies to the default Player. With this option, you can 
determine the name on the tab for the default Player. 
   

 Tabs: There are three options in the Tabs section.  
 
The first option is the Tab Text field. This allows you to specify the text you want to 
appear on the tab. 
 

The second option is the Type list, which has three choices. Use the Player with 
Context Sensitivity option to launch a Player with an outline filtered to the topics 
appropriate to the location in the target application from which it is launched. Use the 
Player option to launch any Player content. These two Player options are not subject to 
the language or other content segmentation that you may configure. Use the URL 
option to launch a website or page on the Internet or intranet. Depending on the 

target application you are configuring, an option may also appear to launch the target 
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application help. 

   

Note: You should verify that there is valid content at the specified URL. 
 
The third option is the URL field. Enter the URL to the root of the PlayerPackage folder 
(do not enter a specific page, such as index.html) or to the webpage. 
 

In addition, you can use  and  to add and delete rows, and  and  to change 
the order of the tabs. You cannot change the order of the default player tab; it will 
always be the left most tab. 

   

 Remember Active Tab: If this option is Yes, a cookie is placed on the user's system 
so that the gateway page launches with the tab that was active when the user last 
accessed it. 

   

 Link Menu Text: This option allows you to change the name of the link menu text 
that appears on the gateway page. 
   

 Links: There are three options in the Links section.  
 
The first option is the Link Text field. This allows you to specify the text you want for 
the item on the link menu. 
 
The second option is the Type list, which has three choices. Use the Player with 

Context Sensitivity option to launch a Player with an outline filtered to the topics 
appropriate to the location in the target application from which it is launched. Use the 
Player option to launch any Player content. These two Player options are not subject to 
the language or other content segmentation that you may configure. Use the URL 
option to launch a website or page on the Internet or intranet. Depending on the 
target application you are configuring, an option may also appear to launch the target 
application help. 

 
The third option is the URL field. Enter the URL to the root of the PlayerPackage folder 
(do not enter a specific page, such as index.html) or to the webpage. 

 

In addition, you can use  and  to add and delete rows, and  and  to change 
the order of the links. 

Configure Multi-Language Content  
The options in this feature allow you to configure the help to launch the appropriate content if 
you have developed content in multiple languages. This feature is only available for certain 

target applications.  
  
Note: The Default Player tab in a tabbed gateway configuration honors language or any other 

segmentation.  

 Content URLs by Language: This option has two fields, Language and Content URL. 
Use the Language list to select a language, and then enter the URL to the root of the 
player package for that language in the Content URL field. Do not append index.html 

or any other page. You can click  to add new rows as necessary to support all 

available languages, and click  to remove languages that you no longer need. 

 

 Default Content URL: This is a URL to the content to be launched if the language is 

not defined in the Content URLs by Language list. For example, if you have defined 
English, Spanish, French, and German, and someone logs on in Italian, you can 
specify that the English content should be launched. The Player content being 
configured (for example, the one from which you launched the Configuration Utility) 
will be used if there is no language match. 
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Configure Advanced Options  
The options in this feature allow you to control how the outline appears when the content is 

launched, and point to the content if the scripts folder is moved.  

 Outline Display: If you have configured the content to launch with context-
sensitivity, then the outline will only contain the items which are related to the task 
the user is performing in the target application. This is called applicable content, and it 
is the default setting. If you want the entire content outline to display instead, you can 

change this option to show all content. Users can switch between applicable and 

all content views in the Player. 

Special Options  
Certain target applications have special options. Most of these appear under Advanced options 

as necessary. If there are special options for the target application you are configuring, see 

the following sections for more information.  
 

To configure application-specific options:  

1. Launch the Configuration Utility.  

   
2. Click the target application link that you want to configure. 

   

3. Change settings as appropriate.  
   

4. Save the configuration. 

2.2.4 Oracle E-Business Suite Special Options 

The following option is available for Oracle E-Business Suite:   

 Oracle Version: Specify 11i or R12. This is needed for language segmentation to 
work properly. 

2.2.5 SAP GUI for HTML and Windows Special Options 

The following options are available for SAP GUI:  
 
Configure Content Segmentation and Multiple Languages 
In SAP, you can segment the content by GUI Type and SAP User Parameter in addition to 
language.  

 Segment Content By: This option allows you to choose the type of segmentation. 
When you change this option, the fields in the Content URLs by Segment adjust 

accordingly. 

     

 GUI Type: If you choose to segment content by GUI type, this field appears, allowing 
you to specify the GUI for each content URL. 

     

 SAP Param: If you choose to segment content by SAP User Parameter, this field 

appears, allowing you to enter the value of the SAP user data for each content URL. 
   
Note: To use this parameter for segmentation, the parameter /GKOD/Y_ROLE must be 
created in each SAP user's Master Record (transaction SU01). The values in the Master 
Records and the values in the SAP Param field must match for the appropriate content 
to be returned.  



Implement In-Application Support 

 

 10 

Additional Options     

 Partial Context: When you record content, context IDs are captured, which allows for 

context sensitivity. In SAP, these context IDs can consist of up to three components: 
the transaction code (T), the program name (P), and the screen number (S). You can 
enter the appropriate value to control which of these components are used to find 
applicable content. The default is to use all three components. 
   
Note: This option is only required if you have context sensitivity issues. Contact 
Technical Support before using it. 

2.3 Deploy the Content on a Web Server 
Once you have published and configured your content, copy all the content and place it in a 

location that is accessible by HTTP or HTTPS protocols. If you are implementing SmartHelp, 
you should give this URL to your end users so that they can install SmartHelp. If you are 
implementing help integration, you must use this URL when you configure the target 

application.  

2.4 Integrate Help in Target Applications 
If help integration is available for a target application, there is usually some configuration that 
must be done on the application server. This section outlines the configuration for each target 
application. 

2.4.1 Agile CNM 

Agile CNM can be configured to launch context-sensitive help through the Help button. When 

the user clicks the Help button, the Player help launches directly or a gateway page appears 
allowing the user to choose between the Player help and the Agile CNM help.  
 

A System Administrator can configure the Agile CNM application to launch the context-
sensitive Player help from the Administration link inside the application. 
 

To configure Agile CNM: 

1. Log in to the Agile CNM application. 

  
2. Click the Administration link. 

  
3. Click the System Settings link. 

  
4. Click in the Online Help URL field. 

  

5. Change the URL to point to the agilecnm_gateway.html file inside the Player Package. 
   
Example: http://<server>/<directory>/agilecnm/hemi/agilecnm_gateway.html 
  

6. Click Save. 

2.4.2 Agile PLM 

Agile PLM can be configured to launch context-sensitive help through the Help button. When 
the user clicks the Help button, the Player help launches directly or a gateway page appears 

allowing the user to choose between the Player help and the Agile PLM help.   
 
You configure the Agile PLM application to launch the context-sensitive Player help directly 
from the Help button by using the Java client interface for administration.  
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Note: For customers using Agile Pharma inside version 9.3.1, a server side configuration is 
necessary to configure the help link to launch Player content. The file name is CFMConfig.xml 
and is located under <Agile_Home>\AgilePharma\config. In this xml file, locate the 

<AgileHelpUrl> variable and configure it to point to the Player Package. Below is an example:  
 
<AgileHelpUrl>http://<server>/<directory>/agile/hemi/agile_gateway.html</AgileH

elpUrl>  

  

To configure Agile PLM:   

1. Log in to the Agile Java client application.  

     
2. Click the Admin tab.  

     
3. Expand the Server Settings item in the tree.  

     
4. Double-click the Locations item in the tree.  

     
5. Click the Online Help Manuals URL field.  

     
6. Enter the server and virtual directory where the published Player content is located, 

for example: 
   
http://<server_name>/<folder_name>/agile/hemi/agile_gateway.html 

     
7. Click the Close button.  

     
8. Click the Yes button.  

2.4.3 JD Edwards EnterpriseOne 

In the P98MOQUE file, update the Helps path to point to the pste1_gateway.html file in the 
/psentone/hemi folder. This path should be a URL path based on your virtual directory 
setup. 

    
For example: 

http://<server>/<dir>/psentone/hemi/pste1_gateway.html   
  
It is a good idea to make a note of the original PeopleBooks help URL in case you want to use 
it later. 

 
Note: While setting up the Media Object Queues you may use Help Content as the Queue 
name and point to pste1_gateway.html file under ..\psentone\hemi in the published content 
folder as the On-Line and Off-Line Queue paths. 

2.4.4 JD Edwards World 

The instructions that follow are for the JWalk Java client interface. A button to launch Player 
content appears on the program menus; no configuration is necessary for this button to 
appear. However, it must be configured to point to the Player help content through entries in 

two text files.  
 
To launch the context-sensitive help content, the JD Edwards World Web Enablement 
administrator needs to set entries appropriately in the WV9100.JVM and DYNBLD9100.JVM 
text files. These files are located within the Deployment area of the JWalk server or client. 

 For the iSeries-i5 Installation: 

www/<HTTP server>, such as apachedft/htdocs/JWALK/JWALKAPP/A9100APP  
  

 For the Windows NT-2000-2003 Server Installation: 
C:\Inetpub\wwwroot\JWALKAPP\A9100APP or 
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C:\Program Files\Apache Software 
Foundation\Apache2.2\htdocs\JWALKAPP\A9100APP 

The Text File entries to be updated are: 

 UPKVIEWI: Set this to Y to display the Context aware icon on the program menus. 
  

 UPKVIEWH: Set this to Y to display the View Content Option from the Help Drop Down 
menu. 

  

 UPKHELP: This displays text when hovering over the Context aware icon. 
  

 UPKHELPOPT: This displays text for the option on the Help Drop Down menu. 

  

 UPKPath: This should be set to the path of the content location. For example: 

   
http://<server>/<virtual directory>/jdeworld/hemi/jdeworld_gateway.html?CTXEX= 

If you place the help content on the Windows server supporting the JWalk client interface, no 
additional configuration is necessary. If the help content is on a non-Windows server, you 
need to configure the odcustomurl.js file. 

2.4.5 Oracle E-Business Suite 

To implement Help Integration for Oracle E-Business Suite, you must install and compile two 
library files that are delivered with the Developer installation. To complete the integration, 
modify the HELP_WEB_AGENT profile on the Oracle server to point to the Player content. This 

causes the Player interface to launch directly from the Oracle Help menu. 
 
Implement Context-Sensitive Help Integration 
If you want to implement context-sensitive help for Oracle E-Business Suite applications, the 
correct Context IDs of the objects in Oracle must be captured while the content is recorded. To 
enable this in Oracle E-Business Suite 12.1.1 or earlier, you must deploy or modify the custom 

library (CUSTOM.pll) on the Oracle server you will use to record the content. This must be 

done before you begin to record content. To enable this in Oracle E-Business Suite 12.1.2 or 
later, you can add an entry in the System Profile form. 
 
Enable Context Recognition in Oracle E-Business Suite 12.1.1 or Earlier 
To enable context recognition, you must either deploy a custom library or modify an existing 
one, and then modify the HELP_WEB_AGENT profile. The custom library is required for 
recording content only. It is not necessary for deployment of context-sensitive content from 

Oracle E-Business Suite. If you use the different systems for development (content creation) 
and production (deployment), then the custom library configuration is not necessary in the 
production environment. If you use the same system for development and production, then 
custom library only needs to be installed while the content is being recorded. 
 
Enable Context Recognition in Oracle E-Business Suite 12.1.2 or Later 

In Oracle E-Business Suite 12.1.2 or later, you add a profile in the System Profile form. 
 

To enable context recognition in Oracle E-Business Suite 12.1.2 or later: 

1. Launch the Oracle E-Business Suite application. 

  
2. Click the System Administrator link. 

  
3. Click the Profile>System link to launch the System Profile form. 

  
4. Enter %UPK% in the Profile field. 
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5. Click the Site field and change the value to Yes to enable context recognition.  
This change is available to all users in the E-Business Suite application. 
  

6. On the File menu, click Save. 

  
7. On the File menu, click Exit Oracle Applications and click OK. 

Check Existing Custom Library Configuration 
The .pll delivered with the Developer is written with SPECIAL7 as the default value. This 
default value is a suggestion. You can use anything between 1 and 15. If you have not created 
any Oracle specific applications that use the SPECIAL event, you can use the default. If you 
have created Oracle-specific applications that do use the SPECIAL event, the value of 7 may 
be taken, and you need to find another suitable unused value between 1 and 15. 
 

You can use the following command lines to find an unused value instead of editing and 
recompiling the custom.pll file repeatedly: 
 
cd $AU_TOP/forms/US; grep -i APP_SPECIAL.ENABLE `find . -name "*.fmb" -print`| grep 

SPECIAL7| grep -i PROPERTY_ON 
cd $AU_TOP/resource; grep -i APP_SPECIAL.ENABLE `find . -name "*.fmb" -print`| grep 

SPECIAL7| g rep -i PROPERTY_ON 
 
If you receive a result that looks like the statement below, the value is already being used. 
 
./CSCCCCRC.fmb:app_special.enable('SPECIAL7', PROPERTY_ON); 
 
Deploy a Custom Library 

Use the following steps if you have not deployed a custom Library on your Oracle Applications 
server. 
 

To deploy a custom library: 

1. Back up your existing CUSTOM.pll to CUSTOM.pll.orig. 

  

2. Locate the ODPNCustomPLL.zip file in the ORACLE folder where the Developer is 
installed and extract the CUSTOM.pll and ODPN.pll files. Copy them to the 
$AU_TOP/resource folder on the Oracle Applications server. 
   

Note: $AU_TOP is defined as a variable and references 
/oracle/VIS/apps/apps_st/appl/au in both a Unix and Windows operating system. 
  

3. Ensure that no one is currently using Oracle Applications (Web Forms). Shut down the 
Oracle Forms Server service if you are running 11i. 
   
Note: It is not necessary to shut down any service if you are running R12. 

  
4. While in the $AU_TOP/resource, compile the ODPN.pll and CUSTOM.pll library files 

using the command for your specific EBS version: 
   
Oracle 11.5.10 server: 

ifcmp60 module=ODPN.pll module_type=LIBRARY userid=apps/apps@<instance> 

compile_all=yes 
   
ifcmp60 module=CUSTOM.pll module_type=LIBRARY userid=apps/apps@<instance> 
compile_all=yes 
   
For Oracle E-Business Suite R12: 
frmcmp module=ODPN.pll module_type=library userid=apps/apps@<instance> 

compile_all=yes 
   
frmcmp module=CUSTOM.pll module_type=library userid=apps/apps@<instance> 
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compile_all=yes 

   

Note: Replace the database connect string to reflect your instance. 
   
Note: Shutting down the Forms server is not necessary for Oracle E-Business Suite 
R12. 

Modify an Existing Custom Library 
Use the following steps if you have custom logic in your custom library (CUSTOM.pll) that you 
do not want to overwrite. You must place a line of code in the custom library that will call out 

to a new library (ODPN.pll). After doing this, you will only need to recompile your existing 
CUSTOM.pll if you receive new versions of ODPN.pll with software upgrades. 
 

To modify a custom library: 

1. Back up your existing CUSTOM.pll to CUSTOM.pll.orig. 

  
2. Copy the CUSTOM.pll from the $AU_TOP/resource folder on the Oracle Applications 

server to a client machine that has Oracle Forms Builder installed. 
  

3. Copy the APPCORE2.pll from $AU_TOP/resource folder on the Oracle Applications 

server to a client machine that has Oracle Forms Builder installed. This should be the 
same folder you used for the previous step. 
  

4. Locate the ODPNCustomPLL.zip file in the ORACLE folder where the Developer is 
installed and extract the ODPN.pll file. Copy it to the client machine into same folder 
as previous file copies. 
  

5. Open CUSTOM.pll using Oracle Forms Builder and attach ODPN.pll. Place this file in 
the same folder on the client side as your CUSTOM.pll prior to the attachment. 
  

6. Answer Yes when asked to remove directory path. 
  

7. Add the following code to the Event procedure: 
   

gkod_event (event_name, 'SPECIAL7'); 
   
Note: You may use any number between 1 and 15 in the SPECIAL command as long 
as there are no conflicts. See Check Existing Custom Library Configuration for more 
details. Beginning with Oracle EBS 12.1, the SPECIAL command can be replaced with 
the MENUX command where X is a number between 1 and 15. 

  
8. Ensure that no one is currently using Oracle Applications (Web Forms). Shut down the 

Oracle Forms Server service. 
  

9. Copy the CUSTOM.pll and ODPN.pll files from the client to the $AU_TOP/resource 
folder on the Oracle Applications server. 
  

10. Compile both the ODPN.pll and the CUSTOM.pll files using steps 5 and 6 in the 
previous section. 

Modify the HELP_WEB_AGENT Profile 
You must modify the HELP_WEB_AGENT profile in Oracle to point to the oracle_gateway.html 
in the Player content deployed on the server.  
 
For Oracle E-Business Suite 11i , the URL consists of two parts: the path for the 
oracle_gateway.html file located in the \oracle\hemi folder in the Player content, plus the path 
of the default dbc file for the Oracle server. 
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Following is an example for 11i: 
 
URL=http://<server 

name>:<port>/oracle/hemi/oracle_gateway.html?dbc=d:\oracle\o11iappl\fnd\11.5.0\secure\

<server name>.dbc 
 
Following is an example for R12: 
 
URL=http://<server name>:<port>/oracle/hemi/oracle_gateway.html 
 

To modify the HELP_WEB_AGENT profile in Oracle E-Business Suite: 

1. Sign on to the Oracle EBS Application via the web browser as an administrator. 

  
2. Click the System Administrator link and locate the System Profile. 

  
3. When the java form launches, enter APPLICATIONS_HELP% in the Profile field and 

click Find. 

   
4. Enter or edit the URL with the path to the oracle_gateway.html. 

   

Note: For Oracle 11.5.10, include the location of the .dbc file in the URL string. Once 
you have completed your changes, stop and restart the Oracle Forms service. 
  

5. For the profile change to take effect in the current session, exit from the Oracle 
application and sign in again. 
  

6. Click Help in Oracle, and the Player launches. 

2.4.6 Oracle (Hyperion) EPM 

Player help can be launched through the Help menu for supported Oracle (Hyperion) EPM 
applications. For the Calculation Manager, EPM Architect, Financials Management, and 

Planning applications, the help is context-sensitive. For the Smart View and Financial 

Reporting Studio applications, the help is not context-sensitive.   
  
The help launch for all supported applications is controlled through an option in the Hyperion 
Workspace Server Settings. When you enter a URL in the field, the Oracle User Productivity Kit 
option appears on the Help menu automatically. Note that if the field is blank, the Oracle User 
Productivity Kit may still appear as an option for certain applications such as Financials 

Reporting Studio, but the option is grayed out and unavailable.   
 

To configure the help menu: 

1. Launch and log in to the Hyperion Workspace. 

   
2. On the Navigate menu, choose Administer. 

   
3. Click the Workspace Server Settings menu. 

   
4. In the URI to User Productivity Kit field, enter the URL to the content location. The 

URL should consist of the web server name and the virtual directory where the content 
is located. For example, http://<servername>/<virtualdirectory>. You do not need to 
append any further information. 
  

5. Click OK twice to close the Workspace Server Settings dialog box and save your 
settings.  

  
6. Log off and on to the Hyperion Workspace to apply the URL change. 
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2.4.7 Oracle Fusion Applications 

Fusion Applications can be configured to launch context-sensitive help through the Help menu. 

When a user clicks User Productivity Kit under the Help menu, the Player launches directly 
with an applicable list of topics based upon the application context. 
  
There are two steps to enabling Fusion Applications for context-sensitive content development 
and playback: 

 Enable context in Fusion Applications 

 Configure Help Integration 

Enabling Context in Fusion Applications 

The following must be added to web.xml for context to be enabled. 
  
<context-param> 
     <description> 

     </description> 

    <param-name> 
        oracle.apps.upk.targetapp.context.ENABLE_UPK_CONTEXT_PROVIDER 
    </param-name> 
    <param-value>true</param-value> 
</context-param> 

  
Note: Context must be enabled in Fusion Applications prior to any content authoring sessions. 
This ensures the Developer/Recorder will automatically capture context during recording. A 
server reboot is NOT required when adding this through Enterprise Manager. However, the 
deployed application needs to be restarted through the WLS console. These steps must be 
repeated after each Fusion Apps patch is applied. Customers are advised to follow already 
established guidelines for uptaking Fusion Apps patches. 

  

Help Integration in Fusion Applications 

The configuration for Help Integration is done within the Functional Setup Manager (FSM). By 
registering the enterprise application through FSM, you can configure the User Productivity Kit 

link to launch content in a context-sensitive manner. The launch URL from Fusion Applications 
is pre-defined to be as follows: 

  
<protocol>://<host>:<port>/upkcontent 
  
It is important that your content location adheres to the above mentioned pattern, for 
example: 
  

http://content.mycompany.com:8080/upkcontent 
(http://content.mycompany.com:8080/upkcontent) 
  
In the Fusion Applications provisioning data for the context root value for the “upk” module is 
set to “upkcontent” – this value is automatically appended to the content location host/port 
information that you define in the steps below. While you may physically place your content 
anywhere on the server, you must map the “upkcontent” virtual directory at the root of your 

server so that the Player can be launched by navigating to: 

  
<protocol>://<host>:<port>/upkcontent/index.html 
  
For example: 
  
http://content.mycompany.com:8080/upkcontent 

(http://content.mycompany.com:8080/upkcontent)/index.html 
  
The configuration of Fusion applications for HINT requires the use of a tool known as 
Functional Setup Manager (FSM). Proper security access is required. With proper security, the 
Register Enterprise Applications menu appears under the Topology Registration Section of 

http://content.mycompany.com:8080/upkcontent
http://content.mycompany.com:8080/upkcontent
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FSM. The steps below assume the necessary steps for context enablement have been 
completed. For additional information, please see Oracle Fusion Applications Post-Installation 
Guide for your release. 

  

You must have access to the WLS Administrator security role as well as one of the other roles: 
 
Application Implementation Administrator 
Application Implementation Consultant 
Application Administrator 
Application Developer 
  

To configure the Oracle Fusion Application for Help Menu integration: 

1. Launch the Functional Setup Manager. 
   

2. Click the Register Enterprise Applications link. 
   

3. Click the Add button to add a new registration to the Fusion application. The 

application you are registering is Oracle User Productivity Kit. 
   

4. Under the Basic Information section, configure your Enterprise Environment, 

Enterprise Application and Name of the registration. 
   

5. Choose your Enterprise Environment from the list. 
   

6. Search for the Enterprise Application using the Search menu item at the bottom of 
the list. 
   

7. Search for Oracle in the dialog box and click the Search button. 
    

8. In the Name list, click Oracle User Productivity Kit and click OK. 
   

9. In the Name field in the Basic Information section, enter Oracle User Productivity 
Kit as the name for registration. 

   

10. In the Server Details section, configure the Server Protocol you are using to launch 
your content. The Player supports both http and https protocols. 
   

11. In the External Server Host field, enter the name of the server host used for 
external communications; for example, content.mycompany.com. 
   

12. In the External Server Port field, enter the appropriate port, either http or https. 
The default port for http is 80 and 443 for https. 
   
Note: In the Associated Modules section, note that the value in the Context Root field 
is "upkcontent". This should be the name of the virtual directory where the content is 
located. This is a non-editable field. 
   

13. Click the Save and Close button. The Oracle User Productivity Link will appear under 
the Help menu. Users must log out and log back in to Fusion to accept the changes. 

2.4.8 Oracle Knowledge Center 

To implement help integration for Oracle Knowledge Center, replace the pre-existing help for 
each language, as desired. The help systems are located in a Help folder within the location 
where the Knowledge Center is installed. In a default installation, the location is: 
 
C:\Program Files\User Productivity Kit\Knowledge Center\Web 

Server\KCenter\Documentation 
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Within the Help folder, there is a folder for each language, designated by a two-letter code, for 

example, EN for English and DE for German. Within each language folder, there are three 

folders, each containing one of the help systems for the Knowledge Center: 

 KCenter: The help for the main user interface. 
   

 Manager: The help for the Manager application, which launches when a user clicks the 

Manager link in the Navigation pane. 
   

 Reports: The help for the Reports application, which launches when a user clicks the 
Reports link in the Navigation pane. 

Each folder contains a Player package. Copy the Player package with your customized help 

into the appropriate folder. For example, to replace the default help with customized help for 
the Knowledge Center main interface in English, go to this folder: 
 
C:\Program Files\User Productivity Kit\Knowledge Center\Web 

Server\KCenter\Documentation\EN\Help\KCenter 

 

Note: It is highly recommended that you zip the existing Player package as a backup before 
you copy the customized package. 

2.4.9 PeopleSoft 

The Player supports two methods of configuration for the Web Profile helpurl configuration, 
local or hosted PeopleBooks. To properly record context IDs in a PeopleSoft application, you 
must set the HelpURL field inside your active Web profile configuration to point to the 
pst8_gateway.html file, and append the context parameter string that makes up the URL.  
  
Whether you choose to use a local version of PeopleBooks or a version hosted by Oracle, you 
must configure the HelpURL field to point to the published PlayerPackage and use the 

appropriate query string of parameters based upon your choice. 
  
Local PeopleBooks configuration: 

http://<server>:<port>/<directory>/pst8/hemi/pst8_gateway.html?ContextID=%CONTEXT_I
D%&LangCD=%LANG_CD% 
   

Hosted PeopleBooks/Universal Linking configuration: 
http://<server>:<port>/<directory>/pst8/hemi/pst8_gateway.html?id=%CONTEXT_ID%&ctx
=<first ul value>&ctx=<second ul value> 
 
Note: For additional information about hosted PeopleBooks, see the PeopleBooks Online 
Library at 
http://docs.oracle.com/cd/E17566_01/epm91pbr0/eng/psbooks/psft_homepage.htm. 

 
Use the Configuration Utility (inappconfig.cmd) to configure a link in the Player gateway page 
for PeopleBooks; for example, http://www.oracle.com/pls/topic/lookup. 

2.4.10 Primavera Contracts Management 

The Primavera Contracts Management application can be configured to display a User 
Productivity Kit link in the page menu. To configure this feature, the system administrator 
must use the Primavera Administrator tool.  
  

To configure the Primavera Contracts Management application to display the User 

Productivity Kit link:  

1. Launch the Primavera Administrator tool. 

   
2. Expand the User Productivity Kit folder. 

   



  Implement In-Application Support 

   19 

3. Change the Enable User Productivity Kit setting to true. 
   

4. Enter the server and directory location on your web server in the User Productivity 

Kit URL setting. 

   
5. Save the settings. 

   
6. Restart the Weblogic web services.  

   
Once the web server restarts, the new link appears in the page menu. 

2.4.11 Primavera P6 

Primavera P6 can be configured to launch context-sensitive help through the Tutorials link in 
the Help menu. When the user clicks the Tutorials link, the Player help launches. You can 
create your own custom content and point the Tutorials link to it. 
 

To configure the Tutorials link to launch your custom content: 

1. Launch the Administrator tool. 

   
2. Expand the Primavera P6 Configuration folder in the Custom folder. 

   
3. Expand the Application folder and then the Tutorials folder. 

   
4. Edit the Enable Tutorials field and change it to true, if necessary. 

   
5. Edit the Tutorials URL field to point to the custom content location. You only need to 

specify the server and the virtual directory; for example, http://<server>/<virtual 

directory>. 
   

6. Click Save Changes. 

2.4.12 SAP GUI for Windows and SAP GUI for HTML 

To integrate published help content with SAP GUI clients, you must perform the following 
steps: 

 Register an object in SAP Service Marketplace.  
  

 Copy the transport files to the SAP server.  

  

 Import the transport files into the SAP system.  

  

 Customize the SAP Help menu.  
  

 Edit ABAP code to customize the “help_start” function in SAP to launch the Player.  

  

 Configure the Gateway URL. This step requires configuring the URLs to point the 

content for SAP.  
  

 Translate the Help menu, although this step is optional. 

For the installation, an SAP Service Marketplace user with administration rights is required. In 
the target SAP system, a user with developer rights, registered as a developer, is required. 
 

Register an Object in the SAP Service Marketplace System  
An SAP Administrator or someone who has administrative rights for the target SAP installation 
in the SAP Marketplace must perform this procedure. 
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Register the following object: "PgmID:R3TR, Object:FUGR, ObjectName:SHL2" and make a 

note of the access key. 

 
Copy the Transport Files to the SAP Server  
The transport file contains two files, Kxxxxxx.nnn and Rxxxxxx.nnn, where x and n will vary, 
depending on the version of the Developer that the transport is from. These files must be 
copied to the SAP server. They are contained in a file called HEMITransport.zip and are located 

in the front folder in the Developer installation. 
  
Note: You will need an unzip utility such as WinZip to unzip the files. 
  
The details for the next steps are in the sections that follow. The procedures may vary, 
depending on your SAP version. Procedures for 4.6c and ECC6 are provided as examples. 

2.4.12.1 Import the Transport Files 

The transport files that were copied to the SAP server need to be imported into the SAP 
system. A Basis administrator should perform this step.  
 

All objects in this transport are located in the registered development namespace /GKOD/. 
This development namespace ensures that no naming conflicts can arise in your SAP system 

because of the transport. 
  
Note: If you want to check the import logs of the transport, select the Goto menu and then 
the Import History command. A return code 4 (Warning) and below is acceptable.  
  

To import the transport files to an SAP version 4.6c or ECC6 server: 

1. Log on to SAP as a Basis administrator. 

   
2. In the Transaction Code field, enter stms. 

   

3. Click  (Enter). 

   

4. Click  (Import overview). 

   
5. Double-click the import queue of the target system. 

   
6. On the Extras menu, point to Other requests and choose Add. 

   
7. In the Transp. request field, enter nnnKxxxxx, where nnn and xxxxx match the name 

of the transport file that was unzipped. 
   

8. Click  (Continue). 

   
9. Click Yes. 

    
10. On the Queue menu, choose Close. 

   

11. On the Queue menu, choose Start import. 

   
12. In the Target client field, enter the number of the appropriate client. 

   

13. Click  (Continue). 

   
14. Click Yes. 

   

15. Click  (Refresh). 
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16. Click  (Exit) twice. 

Special Note for SAP Unicode-based Systems  
If your SAP System is Unicode-based, please apply the transport in the following manner via 
the command line. 
  
Verify that your instance profile has the following parameter set: abap/unicode_check=on.  
 

Apply the transport using the following procedure: 

1. Open a command line prompt. 
  

2. Type the following: 
   
tp addtobuffer nnnKxxxxxx <SID> pf=C:\usr\sap\trans\bin\TP_DOMAIN_<SID>.PFL.  
   
Note: C:\ should be replaced with the appropriate path, if necessary. 

  
3. Type the following: 

   
tp import nnnKxxxxxx <SID> -Dsetunicodeflag=true client<num> 
pf=C:\usr\sap\trans\bin\TP_DOMAIN_<SID>.PFL. 

If your system is Unicode, refer to SAP Note 330267 before importing the content. 

2.4.12.2 Customize the SAP Help Menu 

Once the transports have been imported into the SAP system, you must customize the SAP 
System Help menu to launch Player content by creating a menu item with 'Code' ZOND and 

'Functional Type' H. 
  

To customize the SAP Help menu on a version 4.6c or ECC6 server: 

1. Log on to SAP as a user with developer rights. 

   
2. In the Transaction Code field, enter se41. 

   

3. Click  (Enter). 

   
4. In the Program field, enter MENUSYST. 

   

5. In the Status field, enter MEN. 
   

6. Click  Change. 

   

7. Click  (Continue) twice to respond to messages in the Menu Painter: Initial Screen 

box. 

   
8. Click Maint. in orig. lang. 

   

9. Click  (Continue). 

   

10. Click  next to Menu bar. 
   

11. Double-click the Hilfe entry in the list. 
   

12. Click the ERHI entry in the list. 
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13. On the Edit menu, point to Insert and choose Separator line. 

   

14. Click  (Continue).      

15. On the Edit menu, point to Insert and choose Entry. 
   

16. In the Code field, enter ZOND. 

   
17. In the Text field, enter the text that you want to use for the menu entry that launches 

the Player. 
   

18. Double-click the Code field in which you entered ZOND. 
   

19. In the Functional type field, enter H. 
   

20. Click  (Continue). 

   

21. On the Extras menu, choose Active functions in multiple statuses. 
   

22. Click  (Continue). 

   
23. Select all of the options in the Status column. 

   

24. Click  Copy. 

   

25. Click  (Activate). 

   

26. Click  (Create request). 

   
27. In the Short description field, enter the desired text. 

   

28. Click  (save).      

29. Click  (Continue). 
   

30. Click  twice. 

2.4.12.3 Customize the HELP_START Function 

In this process, you must edit code to customize the “help_start” function in SAP. This function 
launches SAP Help menu commands and must be modified to launch the Player with special 
parameters. 
 
Note: The status message "Object FUNC_HELP_START is part of the Basis interface; further 
development not allowed" may appear. This message is not an error, and you should continue 

with the procedure.  
  

To Customize the HELP_START function on a 4.6c server:  

1. Log in to SAP with developer rights. 

   
2. In the Transaction Code field, enter se37. 

   

3. Click  (Enter). 
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4. In the Function module field, enter HELP_START. 
   

5. Click  Change. 

   
6. Enter your user access key and the access key for the object that was registered in the 

SAP Service Marketplace system. 
   

7. Click Continue. 
   

8. Click  (Continue). 

   
9. Click Maint. in orig. lang. 

   

10. Click  (Find/Replace). 
   

11. In the Find what field, enter when 'GLOS'. 
   

12. Click Find Next. 
   

13. Click Cancel. 
   

14. Click in the workspace to position the insertion point before the when 'GLOS' 

statement. 
   

15. Click  Insert. 

   
16. Enter OnDemand Include and press ENTER twice to create two blank lines under the 

*OnDemand Include statement. 
   

17. Click the first blank line you just created and enter include 
/GKOD/Y_START_ONDEMAND. 

   

Note: The period at the end must be included in the statement. 
   

18. Click  (Check). 

   

19. Click  (Activate). 

   

20. Click  (Continue). 

   

21. Click  (Exit). 

   

22. Click  (Activate). 

   

23. Click  (Continue). 

   

24. Click  (Exit).  

To Customize the HELP_START function on an ECC6 server:  

1. Log in to SAP with developer rights. 

   
2. In the Transaction Code field, enter se37. 
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3. Click  (Enter). 

   

4. In the Function module field, enter HELP_START. 
   

5. Click  Change. 

   
6. Enter your user access key and the access key for the object that was registered in the 

SAP Service Marketplace system. 
   

7. Click Continue. 
   

8. Click  (Continue). 
   

9. Click Maint. in orig. lang. 

   

10. Click  (Find/Replace). 

   
11. In the Find what field, enter when 'GLOS'. 

   
12. Click Find Next. 

   
13. Click Cancel. 

   
14. Click in the workspace to position the insertion point before the when 'GLOS' 

statement. 
   

15. Click  Insert. 
   

16. Enter OnDemand Include and press ENTER twice to create two blank lines under 

the *OnDemand Include statement. 
   

17. Click the first blank line you just created and enter include 
/GKOD/Y_START_ONDEMAND. 
   
Note: The period at the end must be included in the statement. 
   

18. Click  (Check). 
   

19. Click  (Activate). 
   

20. Click  (Continue) twice. 

   

21. Click  (Exit). 

   

22. Click  (Activate). 

   

23. Click  (Exit). 

2.4.12.4 Configure the Gateway URL 

In this process, you configure the help menu entry you created to point your deployed 

content. The content must be installed on a Web server to determine the correct URLs to enter 
into the system.  
  
You can set up the URL to call Player content in any client, or you can set up client-dependent 
base URLs. When you enter a Default Base URL and select the Enabled option, the entry is 
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used to call Player content in any client by default. If you save the entry with the Enabled 
option deselected, the Default Base URL is not used in the system. If you do not want to use 
the Default Base URL, you must still enter an empty string in the table. If the entry is not 

defined, you will receive an error message. 

 
You can create client dependent base URLs as well. If there is no entry in the Client Dependent 
Base URL table for a specific client, the Default Base URL is used for that client. When the 
Enabled option is selected for a client, then the URL for the client is taken as the Base URL. 
When the Enabled option is deselected for a client, then Player content is deactivated in the 
client, and users will receive an error message when calling Player content. 
 

You must log in to the SAP system as a user with developer rights. Since the table you will be 
using is defined as client independent, you can log in to any client to change the entries. 
  

To configure the Gateway URL on a 4.6c or an ECC6 server:  

1. Log in to SAP as a user with developer rights. 

  

2. In the Transaction Code field, enter /n/GKOD/SS. 
  

3. Click  (Enter). 

   

4. Click Default Base URL. 
   

5. In the Default Base URL field, enter the URL to the sap_gateway.html page in the 
content for SAP on the web server. This must be a fully-qualified URL 
containing the sap_gateway.html page.  
   
Note: The sap_gateway.html page is located in the front\hemi folder within the Player 

package. 
   
Example: //<webserver>/Player/front/hemi/sap_gateway.html. 
   

6. Click the Enabled option. 
   

7. Click  (Save). 

   

8. Click  (Continue). 

   
9. Click Client Dependent Base URL. 

   

10. Click  Maintain. 
   

11. Click  (Continue). 

   
12. Click New Entries. 

   

Note: The following steps are for adding a URL pointing to the content that is client-
dependent. These steps configure the SAP system to launch content from a specified 
URL depending on the client number in which the user logged in. You can use any 
valid SAP client number for these steps. You can also use multiple entries for multiple 
clients. 
   

13. In the Client field in the first row of the table, enter a client number. 
   

14. Click Enabled. 
   

15. In the Base URL field in the first row of the table, enter the path to the 
SAP_gateway.html page in the content for SAP on the web server. 
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Note: This URL can be different than the one above.        

16. Click  (Save). 
   

17. Click  (Exit) twice. 

   
18. Click Check Configuration. 

   

19. Click  (Exit). 

2.4.12.5 Translate the Help Menu 

You can translate the SAP menu items into different local languages. The Help menu will then 
appear in the language that the user specified while logging in to the SAP GUI. 
  

To translate the Help menu on a 4.6c server: 

1. Log in to SAP as a user with developer rights. 

   
2. In the Transaction Code field, enter se41. 

   

3. Click  (Enter). 

   
4. In the Program field, enter MENUSYST. 

   
5. In the Status field, enter MEN. 

   
6. On the Goto menu, choose Translation. 

   

7. Click the Target Language field and enter the language code. 

   

8. Click  (Translate). 

   

9. Click  (Find). 
   

10. In the Find field, enter the text that you used for the menu entry that launches the 
Player. 

   

11. Click  (Find). 
   

12. Click the text that you want to translate. 
   

13. Enter the menu text in the target language. 

   

14. Click  (Save). 
   

15. Click  (Exit) twice. 

To translate the Help menu on an ECC6 server: 

1. Log in to SAP as a user with developer rights. 

   
2. In the Transaction Code field, enter se41. 
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3. Click  (Enter). 

   

4. In the Program field, enter MENUSYST. 
   

5. In the Status field, enter MEN. 

   
6. On the Goto menu, choose Translation. 

   
7. Click the Target Language field and enter the language code. 

   

8. Click  (Translate). 

   

9. Click  (Find Text). 
   

10. In the Find field, enter the text that you used for the menu entry that launches the 
Player. 
   

11. Click  (Copy). 

   

12. Click  (Sequential). 

      
13. Enter the menu text in the target language. 

   

14. Click  (Save). 

   

15. Click  (Exit). 

   

16. Click  (Back). 

   

17. Click  (Exit). 

2.4.13 Siebel CRM (On Premise High Interactivity and Open UI Applications) 

Content will be launched directly from the Contents link from the Siebel Help menu. It is also 
possible to create a link to the Player in the existing Siebel Help page. 
  
An administrator needs to add the following MIME types to the Web server: 

  
text/x-component  
  
Note: Refer to the Technical Specifications for a list of supported versions of Siebel server.  
 

To set up help integration on the Siebel web server: 

1. Go to the Siebel application server and find the …/SWEApp/Public/ (installation) folder. 

  
2. Find the folder for the language of the content you recorded and locate the Help folder 

within it, then find and open the Siebhelp.css file and edit it as described in the next 

step.  
  

3. Add the behavior:url command to the body section as indicated below: 
   
body { 
margin-top: 4px; 
margin-bottom: 4px; 
font-family: Verdana, Geneva, Arial, Helvetica, sans-serif; 
font-size: 8pt; 
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behavior:url(../hemi/odgateway.htc);  
-moz-binding: url(../hemi/odgateway.xml#odgateway.htc); 
} 
   

4. Save the Siebhelp.css file.  
  

5. Locate the /hemi folder under Siebel7 in the published content folder.  
  

6. Copy the /hemi folder and paste it in the language folder on the Siebel server. 
   
Note: Do not move the /hemi folder; be sure to copy it only. The folder must remain 
in the published content folder. 

  
7. Repeat this procedure for every language you want to configure. 

Note: If you want the Contents link to open the Siebel Help page with the Player link in the 

header area, change the Show Siebel Help option in the Configuration Utility.  

2.5 Install SmartHelp for Browser-based Applications 
For browser-based applications, the SmartHelp toolbar button can be used to deploy in-
application performance support. SmartHelp can be used for context-sensitive ExactMatch or 
SmartMatch content for various target and non-target applications.  
 

The traditional Help Integration approach is recommended for deploying context-sensitive in-
application performance support content for a single target application as it does not require 
the SmartHelp toolbar button to be distributed to end-user desktops. However, if content is 
being deployed for multiple browser-based target applications or for non-target applications, 
then SmartHelp may be a consistent way to deliver help for all browser-based applications.  
 
SmartHelp is a toolbar button for Internet Explorer and Firefox browsers. Browser-based 

applications that suppress the browser's toolbar may not take advantage of the SmartHelp 
features. SmartMatch functionality for non-target applications (statistically relevant content 
items ranked in order to generate the list of applicable content items) is only available with 
the SmartHelp toolbar button. 

 
It is possible to configure the same SmartHelp toolbar button to deploy multiple browser-
based target applications as well as non-targeted applications. The end users will benefit from 

ExactMatch behavior when using the SmartHelp toolbar button for target applications and 
SmartMatch behavior when using the SmartHelp toolbar button for non-targeted browser-
based applications. 
  
There are two ways to deploy the SmartHelp toolbar button. One is to enable users to 
navigate to an html page which runs a script to install the button on their local workstation. 

The other is to have an administrator create a silent installer using the executable for a silent 
install. 

2.5.1 Install SmartHelp for Microsoft Internet Explorer 

An ActiveX control must be installed on the end-user system to enable the SmartHelp for 
Internet Explorer. A key feature of ActiveX controls is their simple “download and execute” 

deployment model. 
  
Note: Refer to the Technical Specifications for a list of supported versions of Internet 

Explorer.  
 
The user who installs, configures, and uninstalls SmartHelp must have administrator rights to 
the local computer. Medium or medium-low security is recommended for the published 
content. In the Security tab, Local Intranet and Trusted Sites have the recommended security 
levels. For SmartHelp to work properly, the following settings should be as follows: 
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 Download signed ActiveX controls: Enable or Prompt 

  

 Run ActiveX controls and plug-ins: Enable 

  

 Script ActiveX controls marked safe for scripting: Enable 

Note: If Internet Explorer and the operating system have Protected Mode support, the 
content locations and applications used with SmartHelp must have the same Internet Explorer 
mode, either Protected or Unprotected.  

  
Users can install SmartHelp by accessing the following page from Internet Explorer: 
  

http://<server>/<content_directory>/smarthelpsetup.html 
  
In Windows Operating systems at least Power User or higher (Administrator) privileges are 
necessary for installation. System administrators may need to modify permissions for users or 
applicable groups. It is recommended that the URL for SmartHelp is part of an Internet 
Explorer security zone that is equivalent to either Low or Medium-low pre-defined settings. 

 

Troubleshooting  
When the smarthelpsetup.html page displays an error, additional information is available by 
appending ?diagnosticmode to the URL. For example: 
  
http://<server>/<content_directory>/smarthelpsetup.html?diagnosticmode 
 

In most cases, after you restart the browser the new toolbar button will appear automatically. 
However, if the user has customized the Internet Explorer toolbar, the new button may not 
appear. In this case, the toolbar button is added to the choices in the Customize Toolbar 
dialog box, and it will appear if the toolbar is reset. For more information, see the article on 
the Microsoft Developer Network at http://msdn2.microsoft.com/en-
us/library/Aa753588.aspx.   
  

Note for Internet Explorer 9: When you install SmartHelp and then restart Internet 
Explorer, a message about the SmartHelp Helper appears. Select Enable and then restart 

Internet Explorer again to enable SmartHelp to work. 
 
Depending on the version of Internet Explorer you are using, the entire toolbar may not 
display. The SmartHelp button will be added in the dropdown list area for more buttons. 
 

Upgrade SmartHelp   
If the published content on the server is refreshed or upgraded, the new content could contain 
a newer SmartHelp version with newer resources. The SmartHelp button from the previous 
version cannot load the newer content. For SmartHelp to upgrade itself, the user must launch 
the setup.  
 

If SmartHelp does not work after a browser upgrade, the setup page can be launched to 
upgrade or reconfigure it. 
 
Uninstall from Internet Explorer  

1. Find the SmartHelp Helper bho (currently loaded add-ons) and disable it. 

  
2. Restart the browser. 

 
3. Find the SmartHelp activex (downloaded controls) and remove it. 

  
4. Restart the browser. 
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2.5.2 Install SmartHelp for Mozilla Firefox 

An administrator needs to add the following MIME types to the Web server before the 

SmartHelp button can be installed on Firefox: 
  
.xpi application/x-xpinstall 
.jar application/x-jar 
  
The Web server must be rebooted after the MIME types are set.  

  
Note: Refer to the Technical Specifications for a list of supported versions of Mozilla Firefox. 
  
Users can install the toolbar button by accessing the following page from the Firefox browser: 
  
http://<server>/<content_directory>/smarthelpsetup.html 
 

When installation is complete, users must use the Restart Firefox button in the Add-ons dialog 
box or the button will not be configured properly. Users may then need to add the button to 
their toolbar with the Customize option. 

 
To successfully install the SmartHelp button on Firefox, the location of the deployed content 
must be added to the add-on exception list. 
 

Upgrade SmartHelp  
If the published content on the server is refreshed or upgraded, the new content could contain 
a newer SmartHelp version with newer resources. The SmartHelp button from the previous 
version cannot load the newer content. For SmartHelp to upgrade itself, the user must launch 
the setup.  
 

If SmartHelp does not work after a browser upgrade, the setup page can be launched to 
upgrade or reconfigure it. 
 
Uninstall from Firefox  
Please see Firefox documentation to remove the SmartHelp add-on. 

2.5.3 Use the SmartHelp Installer 

You can deploy the SmartHelp installer using either a manual deployment with a user interface 
and options that the user can select and install, or an unattended installation with no interface 

based on a script that already contains the necessary options to be installed. 
 
When SmartHelp is installed, it adds two entries on the Tools menu of the browser. One menu 
entry, SmartHelp, launches SmartHelp. The other, SmartHelp Options, opens a dialog box in 
which the user can change the hotkey to launch SmartHelp. The default hotkey is F9 at 
installation. 
 

Controlling the List of Plug-ins 
On the Configuration Options screen in the installer, the user can select from a list of plug-ins 
for all browsers installed on the local workstation. An administrator can use the /browser 

command line switch to limit the list to the plug-ins for specific browsers. 
 
Examples: 
smarthelpsetup.exe /browser:IE – only allows IE plug-ins 

smarthelpsetup.exe /browser:IE;FF – allows both IE and FF plug-ins 

smarthelpsetup.exe /browser:all – allows all browser plug-ins 

 
Note: If the installation is being recorded for an unattended installation, the list displays all 
available plug-ins in the installation package, regardless of browsers installed on the machine 

or command line parameters used.  The command line parameter restraints will be respected 
during the running of an unattended installation. 
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Upgrade or Downgrade Plugins 
If newer versions of the available plug-ins are already installed, the corresponding older plug-
in from the installation package being used will not be displayed, unless the /force command 

line parameter is used. For example, if version 2.0 of the Internet Explorer plug-in is already 
installed, and you are installing a package that only contains the 1.0 version of the Internet 
Explorer plug-in, that particular plug-in will not be displayed unless the /force command line 
parameter is used. The installed version of the plug-in will be removed. 
 
A command line switch allows a downgrade install (/force). This installs the plug-ins if there is 
a version installed already, regardless of the installed version. This means that it could also 
upgrade existing plug-ins as well. 
 
smarthelpsetup.exe /force 

 

Create a Response File for an Unattended Installation 
You can use Push technology to distribute executable files for the setup to user desktops. You 
record response files which contain the pre-determined default settings, and then you can run 

the executable silently. If you deploy executable files in this manner, no interaction is 

necessary on the part of the user. The administrator can control the installation. 
 
To create a parameter file, you use the /r parameter to run the setup executable in record 
mode. This generates a response file (.iss) that contains the settings you chose while 
recording. These become the default settings. Recording the installation requires the installer 
to run with the full user interface. 
 
The setup.iss file is stored automatically in the Windows folder. You can use the /f1 option to 
specify a different location in which to create the response file. If the path names contain 
spaces, you must use quotes. The path names should also be absolute, as relative paths may 

have unexpected results. 
 
Example: "<location of the setup file>\smarthelpsetup.exe" /r /f1"<location of the response 
file>\smarthelpsetup.iss" 
 
Sample: "x:\my folder\smarthelpsetup.exe" /r /f1"x:\smarthelpsetup.iss" 
 
Note: When recording the installation options or when running an unattended installation, the 
installer allows all possible plug-in options to be selected for installation, regardless if a 
supported browser is on the machine. When attempting to install a non-supported plug-in, the 
installer logs an error message, but the installation continues. 
 

Unattended Installation 
Once you have recorded a parameter file, you can use the /s parameter to run the setup 

silently. By default, the installation process will look for the response file (.iss) in the same 
directory as the setup.exe. You use the /f1 parameter to specify a different location of the .iss 
file. The response file (.iss) must be either be pushed out with the setup.exe file or reside in a 
location that is accessible to all computers and uses the same drive mapping as is stored in 
the response file. 
 
To run an unattended installation, you must use the standard InstallShield silent install 
parameters in the command line.   
 
/s - runs the installer in silent mode 
 
/f1[scriptfile] - The name of the response file created when running the installer in record 
mode, including the path. 
 
/f2[logfile] - The name of the installation log file created when running the installer in silent 

mode, including the path. This parameter is optional; if it is not used, the log file will be 
created in the same folder as the response file. 
 



Implement In-Application Support 

 

 32 

Example: "<location of the setup file>\smarthelpsetup.exe" /s /f1"<location of the response 

file>\smarthelpsetup.iss" 
 
Sample: "x:\my folder\smarthelpsetup.exe" /s /f1"x:\smarthelpsetup.iss" 
 
SmartHelp specific command line parameters can be used (/browser:[browser] and /force), 
but should come after all InstallShield standard command line parameters.  For example: 
 
smarthelpsetup.exe /s /f1"<location of the response file>\smarthelpsetup.iss" 

/browser:[browser] /force. 

 
To use the SmartHelp installer, open a command prompt window and launch the 

smarthelpsetup.exe file located in the \stdhemi\smarthelp folder in the published Player 
package. You are then prompted to choose the language for the Installer, and the Welcome 
screen appears. During installation, you will proceed through these screens in the Install 
Wizard. 

 Configuration Options: You can choose the appropriate plug-in from the list. The list 

is limited by the supported internet browsers installed on the local workstation. 

   

 Choose Destination Location: You can accept the default target location, or click 
Change to specify a different one. The Destination Location is the target directory 
where the SmartHelp files will be installed. 
   

 Language Selection: Choose the language for SmartHelp. 
   

 Initial Setup: Enter the path to the location of the SmartHelp configuration, in the 

form of "http://<servername>/<virtual_directory>". This is the location of the root 
folder of a Player package on the web server. 
   

 Ready to Install: The Installation Wizard is ready to install the software. Click Back 

to review or modify any settings. 
   

 Setup Status: This screen appears while the plug-ins are being installed and 

configurations are made to the local workstation to enable SmartHelp. 
   

 Installshield Wizard Complete: The plug-ins have been installed. 

2.5.3.1 Uninstall Plugins 

Plug-ins can be individually disabled in the selected browser using the appropriate Tools menu 

option for disabling the plug-ins.  
  
The installer does not add an entry to the Add/Remove section of the Control Panel for 
SmartHelp.  Rather, the installer creates an uninstall batch file that can be run with the 

parameters for removing the individual plug-ins, or all of them at once. By default, running the 

batch file without parameters will remove all installed plug-in files, registry entries, and so on. 

The same result can be accomplished by passing “all” in the command line.  
  
Examples:  
uninstall.bat all – removes all plug-ins  

uninstall.bat SmartHelp_for_Internet_Explorer - removes the Internet Explorer plug-
in  
uninstall.bat SmartHelp_for_Firefox – removes the Firefox plug-in only 
 


